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Introduction

The Cirex FX GUI is a versatile interface that can be used to view and trade on liquidity in the Clrex FX
ECN. This manual is intended to exhaustively detail the functionality of all tools contained in the Ciirex
FX GUI. The GUI provides functionality to place various orders with parameters to meet your trading
needs. In conjunction with trading, the GUI contains a number of detailed order and trade reports that
enable you to review your trading actions. Combining these tool packages enable you to access the
Cirex FX ECN through a ‘point and click’ experience.

Login
After starting the Clirex FX GUI, you will Cirex EX o x
be presented with the login screen. From _
this screen, you will be able to login to —_— i FX
A
the Ciirex FX GUI, change your password : u reX
or alter your connection settings. :

Username | Change Password
1. Credentials password || ST

In the ‘Username’ and ‘Password’ Please log in

fields, enter your username and
password. Once entered, click the ‘Log in’ button and you will be logged onto the platform.

2. Change Password Change Password
By clicking on the ‘Change Password’ link on the login Password must be 8-20 characters, and must

contain at least one of each of the following:
An upper case letter, a lower case letter, a

screen, you will be taken to the ‘Change Password’
screen. Using this screen, you can change your number, aacd a nom alpha: numeric chidracter,

password. To do so, you must enter your username,

User Name

current password, the new password you would like to

Current Password

replace your current password, and finally confirm

New Password

your new password by typing it again. Once you click

Confirm Mew Password

submit, your account password will be changed.
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3. User Preferences

Clicking on the gear icon will open the ‘User

Preferences’ window. Here, you can change the . o Satings

date and number format using the ‘Culture I
Cukture Settings

Settings’ dropdown. The default Ciirex Gateway [Englsh (United States) ]

and Proxy settings should typically be used. Only Girex FX Gatewsy Settings

Use default settings

change these settings if you need to use a custom

Host: | | Port: |0
proxy, or are directed to change theses values by
. . Proxy Settings
Clrex Operations staff. Auto-detect proxy
Host | | Port: | 0

Use default credentials (MTLM)

Usarmname: ! |

Order Types B |
These are the types of orders that can be placed using
the ‘New FX Order’ window.

4. Limit
This order type sets a price and waits for the
market to reach that price before executing.

5. TWAP
This order type acts as a limit, but then attempts to execute portions of the order size over an
interval of time.

6. VWAP
This order type attempts to execute an amount at the price displayed. This may result in multiple
executions with varying rates, but the average will be better than or equal to the submitted rate.

Main Menu
The Main Menu runs across the top border of the application window. This bar provides access to much
of the functionality of the Cilirex FX GUI.

“~ | GirexFX File Options Help

Trade Blotter

7. File
The File menu offers the option to exit the platform, shutting down the Ciirex FX GUI.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
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8. Options

The options menu offers two selections, ‘Preferences’ and ‘Change Password’.

A. Preferences

The Preferences window has three tabs; ot Reiglil
‘App Settings, ‘L t’, and ‘Orders’. T
pp Settings, ‘Layout’, and ‘Orders ol 7
i. App Settings RS
The ‘App Settings’ tab offers identical |

functionality found in the ‘User
Preferences’ window, detailed in section
3.

ii. Layout

The layout tab offers options to manage
your Workspace layouts. Select a saved
layout using the ‘Layout’ dropdown, then
click the ‘Apply’ button to apply this
layout to your Ciirex FX GUI. To save a I

layout, enter a name in the ‘Layout
Name’ field then click the ‘Save’ button.

User Preferences ®

App Settings layout  Orders

The layout you saved can now be found

in the ‘Layout’ dropdown, and applied to

your Cirex FX GUI. The current layout is [P Deuit Prefersnces
Instrument A Max Crder Size % Away Mkt

automatically saved every time you close

Default O o
the Cilirex FX GUI. To delete a saved
.. p , Instrument Specific Preferences
layout, select it in the ‘Layout’ dropdown e 7 MaxOrderSize % Away Mkt
and press the ‘Delete’ button. | =

iii. Orders

The Orders tab offers options to set
safety limits on your order placement.
You can enter a value under ‘Max Order
Size’ to define the maximum order size

you would like to be able to enter. You

may also input a value under ‘% Away

Mkt’ to define the maximum percentage
away from the current market that you would like to be able to enter an order for. Inputting
these settings in the ‘Default Preferences’ section at the top of the window will enable these
limits for all instruments. By clicking the ‘Instrument’ drop down under ‘Instrument Specific
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Preferences’, you can select a currency pair to apply safety limits to. After setting the Max
Order Size and % Away Mkt limits, you must press enter to save the settings for that pair.
Once a limit has been set for a pair, it cannot be deleted. However, safety limits can be
adjusted to larger values to allow greater trading ranges.

B. Change Password
The ‘Change Password’ selection of the ‘Options’ menu provides identical functionality of the
‘Change Password’ screen detailed in item 2.

9. Help

The ‘Help’ menu provides access to the ‘About’ screen, where you can create a log file to submit to
Curex Operations staff, if requested. Click the ‘Send Logs’ button, and a new email to Clirex
Operations staff will be generated using your email client, and your logs will be attached.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
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10. Currency Pair

The ‘Currency Pair’ button will open a new ‘Currency Pair’ window in the active Workspace. Below is
a dissection of this window’s elements.

A B

p
0 C
M
E
M F
L G
4 1 135734 | 135742 3 5
9 5 135733 |5 135744 1 6
11 2 135732 | 1.35747 5 T H
14 3 135732 135749 it |
17 3 13573 135750 3 17
19 2 135726 1.35752 5 22-m )
K

A. Drag Window

Left click and hold on this area to drag the ‘Currency Pair’ window. If inside a Workspace, guides
will appear to show you where the window will snap to.

B. Enable/Disable Floating Window
Left clicking here will cause the ‘Currency Pair’ window to float out of the Workspace. It can

then be positioned anywhere on your screen. Clicking here while the window is floating will
dock it to your active Workspace.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
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C. Close ‘Currency Pair’ Window
Left clicking here will close the ‘Currency Pair’ window.

D. Value Date
This field displays the Value Date for the currency pair displayed in the ‘Currency Pair’ window.

E. Direction of Change
This arrow shows the direction of change from the last price to the current price.

F. VWAP /Top of Book

This field allows you to define a volume to display the Volume Weight Average Price (VWAP), or
the normal top of book price. Left click and enter a value (in millions) to display the VWAP rate
for that amount. Enter zero to display the normal top of book price. You can also use the
up/down arrows to change the VWAP amount.

G. Show/Hide Depth of Book
Clicking this triangular button will expand the ‘Currency Pair’ window to show the full depth of
book, or collapse it to only show the top of book price.

H. Order Size
This column displays the size of orders in the book.

I. Order Price
This column displays the price of orders in the book.

J. Cumulative Available Liquidity

This column displays the cumulative size of all orders in the book at each depth level. Clicking
this field will open a ‘New FX Order’ window populated with the rate and cumulative size,
allowing you to attempt a trade through the book to this level.

K. Depth of Book
This panel displays the orders that comprise the full book.

L. Bid/Offer

Clicking the Bid button will open a ‘New FX Order’ window to buy, populated with the size and
price at the top of the book or the VWAP level, as set in item 6F. Clicking the Offer button will
open a ‘New FX Order’ window to sell, populated with the size and price at the top of the book.

M. Available Liquidity
This field displays the current size of the top of book order.

N. Top of Book Bid/Offer
The red and blue fields display the price of the top of book bid and offer. Clicking the red ‘Sell’
field will open a ‘New FX Order’ window to sell, populated with the size and price at the top of
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the book, or the VWAP amount selected in item 7F. Clicking the blue ‘Buy’ field will open a ‘New
FX Order’ window to buy, populated with the size and price at the top of the book, or the VWAP
amount selected in item 7F.

0. Currency Pair
This dropdown allows you to choose the currency pair that is displayed in the ‘Currency Pair’
window. You can also type the name of a currency pair you are looking for.

P. Collapse/Expand Window
This button will collapse the ‘Currency Pair’ window to a more compressed view, or expand it to
the full window if collapsed.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
The contents of this document are confidential and subject to the terms of the confidentiality agreement.

13



e
11. New FX Order

The ‘New FX Order’ button will open a ‘New FX Order’ window. Below is a dissection of this
window’s elements.

A B
New Order (3]
Product AUDJPY »|  Order Type LIMIT ~
K Buy/Sell e |BUY ~| |[AUD~|  TIF b GIC [ €
] Quarting - 1,000,000|  Account HedgeTest] i 0

Order Rate:

n

G =—=-| BUY 1,000,000 AUD (SELL JPY)

Keep Window Open

A. Product
This dropdown allows you to choose which currency pair you would like to place an order for.
You can also type to find the desired product.

B. Order Type
This dropdown allows you to choose the type of order you want to place: Limit, Volume
Weighted Average Price (VWAP), or Time Weighted Average Price (TWAP).

C. Time in Force
This dropdown allows you to choose the time period your order will be active for. Options are:

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
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i. Good Til Cancel (GTC)
This option will keep the order active until it is cancelled by the user.

ii. Immediate or Cancel (10C)
This option will cancel the order if it cannot be filled immediately. This option is only
available for VWAP orders.

D. Account
This dropdown allows you to choose which account your order will be executed on, if you have
multiple accounts. This field will default to your selection in item 18b.

E. Submit Order
Clicking this button will submit your order for execution.

F. Keep Window Open
If this box is checked, the ‘New FX Order’ window will stay open while your order is being
worked, and after it has completed. You can close the window manually at any point.

G. Order Translation
This field offers a verbose translation of the action your order will take.

H. Top of Book/VWAP
These fields show the current top bid and offer. If you are submitting a VWAP order, they will
display the VWAP price.

I. Order Rate
This is the rate your order will be submitted for. You can type in the rate or use the up/down
buttons to adjust the rate.

J. Order Quantity
This is the size of the order being placed.

K. Buy/Sell
Using these dropdowns, you can change whether you are buying or selling, and change which
currency you are buying/selling.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
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12. New FX Order Window TWAP Specific Fields
If you are placing a TWAP order, there are specific options that you can set for your TWAP order.

Order Type e JWAP ~

s GIC -

Account Curexlestl)... =
Seconds

Time Interval 1 A
Percent

Time Variance o B

Size 500,000 C
Percent

Size Variance o D

Size Rounded Mo - E

A. Time Interval
This field defines the time (in seconds) between attempts to fill a slice of your TWAP order. The
minimum input in this field is 1 (one second).

B. Time Variance

This field defines how much random variance you would like applied to the time between your
TWAP fills. A value of 0 would equate to no variance, and your TWAP would attempt to execute
at the precise interval. A value of 50 would allow a randomized value of +/- half of your Time
Interval. A value of 99 would allow a randomized value of +/- 0.99 times your total Time
Interval.

C. Size
This field defines the amount you would like filled at each Time Interval. The minimum amount
for this field is 500,000.
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The contents of this document are confidential and subject to the terms of the confidentiality agreement.

16



D. Size Variance

This field defines how much random variance you would like applied to your fills at each Time
Interval. A value of 0 would equate to no variance, and your TWAP would attempt to execute
the exact Size at each Time Interval. A value of 50 would allow a randomized value of +/- half of
your Size applied to each execution. A value of 99 would allow a randomized value of +/- your
total Size * 0.99 applied to each execution.

E. Size Rounded

This dropdown allows you to round each randomized execution to the nearest million value.
This takes precedence over Size and Size Variance. If your Size setting is less than 1,000,000 your
execution will be rounded to 1,000,000.

13. FX Order Blotter

Clicking this button will open an ‘FX Order Blotter’ window. You may have multiple ‘FX Order Blotter’
windows open, displaying different data. The ‘FX Order Blotter’ window’s columns may be
rearranged by clicking and dragging the column header. The ‘FX Order Blotter’ window can also be
sorted by clicking any of the columns. Below is a dissection of the ‘FX Order Blotter’ window.

FX 1Jrder Blotier

' '| Filter: | Currert Ordlars '|
Crder Id Status l Pair Amount d Rate

e e 130319000000000013 In Progress USDCAD 1,000,000,00 0.00000
130319000000000012 Cancelled EURUSD Lirmit DAy BUY EUR 500,000.00 1.29180 0.00000

I 130319000000000011 Filled EURUSD Lirmit DAY BUY EUR 500,000.00 1.29462 1.29310
130319000000000010 Rejected EURUSD Limit DAY BUY EUR 3,000,000.00 1.30400 0.00000
130319000000000009 Rejected EURUSD Lirmit DAy SELL EUR 1,000,000.00 1.27408 0.00000
130319000000000008 Rejected EURUSD Lirmit DAY BUY EUR 1,000,000.00 1.30527 0.00000

4 mATA AANANARARARAS L] e e o m L 4 AnAn nAn An 4 Anara 4 Anars

A. Cancel Order
Pressing this button will allow you to cancel an order that is ‘In Progress’.

B. OrderID
This column will display the Order ID for each order.

C. Account
Use this drop down to select which account you want to view orders for. The empty option that
the ‘FX Order Blotter’ window defaults to will display all orders on all accounts.
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D. Status

This column will display the status of the order. Options are: Filled — Order was completed,
Cancelled — User cancelled the order before it was completed, Working — Order is active and
waiting for market to meet conditions, and Rejected — Order was rejected due to credit or safety

limits.

E. Filter

Use this dropdown to select the time period of orders you want displayed. ‘All Orders’ will
display trades for the last seven calendar days, or the last 1,000 trades. ‘Current Orders’ will only
show trades for the past two calendar days, or last 1,000 trades. ‘Open Orders’ will display
orders that are currently working. ‘Closed Orders’ will display orders that have been filled,
cancelled, or rejected.

F. Pair
This column will display the currency pair for each order.

G. Type
This column will display what type of order was placed; a Limit, TWAP, or VWAP. More
information on order types can be found in items 1 — 3.

H. Export
Clicking this button will export your ‘FX Order Blotter’ window to an Excel spreadsheet.

I. TIF
This column will display the Time in Force that was set for the order. Options are GTC and IOC.
These options are detailed in section 8C.

J. Side
This column will display which side the order was on, buy or sell.

K. Dealt CCY
This column will display the dealt currency.

L. Amount
This column will display the amount of dealt currency that was ordered.

M. Rate
This column will display the rate the order was placed for.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
The contents of this document are confidential and subject to the terms of the confidentiality agreement.

18



N. Executed Rate
This column will display the rate that the order was executed at.

o] P Q R 5 T u W WX Y

Order Date Executed Qiy Refhaining Qty Ackount Uder Last Upddte W Reject Reason
3/19/2013 10:29:2.., 0.00 1,000,000.00 S HedgeTlestl test_user  3/19/2013 10:29124 AM
3/19/2013 10:28:5... 0.00 500,000.00 CXTS HedgeTestl test user  3/19/2013 10:29:08 AM
3/19/2013 10:28:5... 500,000.00 0,00 CXTS HedgeTestl test_user  3/19/2013 10:28:50 AM L
3/19/2013 10:27:4... 0.00 3,000,000.,00 CXTS HedgeTestl test user  3/19/2013 10:27:49 AM  Failed risk management filters !
3/19/2013 10:27:3... 0.00 1,000,000,00 CXTS HedgeTestl test_user  3/19/2013 10:27:33 AM  Failed risk management filters t
3/19/2013 10:25:4.., 0.00 1,000,000.00 CHTS HedgeTestl test_ user 3/19/2013 10:25:45 AM  Failed risk management filters

0. Order Date
This column will display the date on which the order was placed.

P. Executed Qty
This column will display the amount of the order that has been executed so far.

Q. Remaining Qty
This column will display the amount of the order that remains to be executed.

R. Firm
This column will display the Firm associated with the trade.

S. Account
This column will display which Account the trade was done on.

T. User
This column will display which User placed the trade.

U. Last Update
This column will display the date and time of the latest order event such as placement,
execution, or cancellation.

V. Reject Reason
This column will display a short message on why the order was rejected, if applicable.

W. Enable/Disable Floating Window

Left clicking here will cause the ‘FX Order Blotter’ window to float out of the Workspace. It can
then be positioned anywhere on your screen. Clicking here while the window is floating will
dock it to your active Workspace.
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X. Maximize/Restore
Left clicking this button will cause the window to be maximized or restored to its previous size, if
floating.

Y. Close ‘FX Order Blotter’ Window
Left clicking here will close the ‘FX Order Blotter’ window.

14. Trade Blotter

Clicking this button will open a ‘Trade Blotter’ window. You may have multiple ‘Trade Blotter’
windows open, displaying different data. The ‘Trade Blotter’ window’s columns may be rearranged
by clicking and dragging the column header. The ‘Trade Blotter’ window can also be sorted by
clicking any of the columns. Below is a dissection of the ‘Trade Blotter’ window.

A B C ] E F G H 1 ] K

v| Filtgr: | Curreni‘Trodes

Order Id Trade Id Status Dealt CCY CCY1 Amount
130319000000000015 130319000100000001 Accepted USDCAD Limit BUY usD 1,000,000,00
130319000000000011 130319000120000005 Accepted EURUSD Limit EUY EUR 500,000.00
130319000000000006 130319000120000003 Accepted EURUSD Limit BUY EUR 1,000,000.00
130319000000000005 130319000120000002 Accepted EURUSD Limit SELL EUR 1,000,000,00
A. OrderID

This column will display the Order ID for each trade.

B. Account
Use this drop down to select which account you want to view trades for. The empty option that
the ‘Trade Blotter’ window defaults to will display all trades on all accounts.

C. TradelD
This column will display the unique Trade ID for each trade.

D. Filter
Use this dropdown to select the time period of trades you want displayed. ‘All Trades’ will
display trades for the last seven calendar days. ‘Current Trades’ will only show trades for the

past two calendar days.

E. Status
This column will display the status of the trade.
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F. Export
Clicking this button will export your ‘Trade Blotter’ window to an Excel spreadsheet.

G. Pair
This column will display the currency pair for each trade.

H. Type
This column will display what type of order initiates the trade; a Limit, TWAP, or VWAP. More
information on order types can be found in items 1 — 3.

I. Side
This column will display which side the trade was on, buy or sell.

J. Dealt CCY
This column will display the dealt currency.

K. CCY1 Amount
This column will display the amount of the first currency that was traded.

Rate CY?2 Amount Trade Date Value Date Firm Account User Last Update W
1.02043 1,026,430.00 3/19/2013 3/20/2013 CXTS HedgeTestl test_user  3/19/2013 10:56:54 AM
1.29310 646,550.00 3/19/2013 3/21/2013 CXTS HedgeTestl test user  3/19/2013 10:28:50 AM
1.29453 1,294 530.00 3/19/2013 3/21/2013 CXTS HedgeTestl test_user 3/19/2013 9:32:05 AM
1.20472 1,294,720.00 3/19/2013 3/21/2013  CXTS HedgeTestl test_user  3/19/2013 3:13:43 AM

L. Rate

This column will display the rate the trade was done at.

M. CCY2 Amount
This column will display the amount of the second currency that was traded.

N. Trade Date
This column will display the date on which the trade was done.

0. Value Date
This column will display the value date for the trade.

P. Firm
This column will display the Firm associated with the trade.
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Q. Account
This column will display which account the trade was done on.

R. User
This column will display which User placed the trade.

S. Last Update
This column will display the date and time of the last update to the trade.

T. Enable/Disable Floating Window

Left clicking here will cause the ‘Trade Blotter’ window to float out of the Workspace. It can then
be positioned anywhere on your screen. Clicking here while the window is floating will dock it to
your active Workspace.

U. Maximize/Restore
Left clicking this button will cause the window to be maximized or restored to its previous size, if
floating.

V. Close ‘Trade Blotter’ Window
Left clicking here will close the ‘Trade Blotter’ window.
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15. FX Positions Blotter

Clicking this button will open the ‘FX Positions Blotter’ window. This blotter will display positions you
have taken, and through a toggle allow you to view trades that contributed to each position. Below
is a dissection of the ‘FX Positions Blotter’ window.

a0
FX Positions Blotter

CurexTestUAT2

ol A

+ Alospy ad'e72 000

L — o EURUSD -1,000,000.00 1,350,670.00
Order 1D Trade ID QCY 2 Amount Trgde Date Last Update W
140131000001000005 140131000021000003 SELL EURUSD Limit -1,000,000.00 134081 134921000 1/31/2014 1/31/2014 2:31:57 PM
140131000001000006  140131000031000002 SELL EURUSD Limit -1,000,000.00 134981 1,349,810.00 1/31/2014  1/31/2014 23147 PM
M— iy 140131000001000002 140131000031000001 BUY EURUSD Limit 1,000,000.00 134895 -1,348,950.00 1/31/2014 173172014 10:58:32 AM

A. Account
Use this drop down to select which account you want to view positions for. The empty option
that the ‘FX Positions Blotter’ window defaults to will display all positions on all accounts.

B. Pair
This column will display the currency pair that the position is in.

C. GO
Click this button to display positions for another account (selected in 15.A ‘Account’).

D. Export
Clicking this button will export your ‘FX Positions Blotter’ window to an Excel spreadsheet.

E. Value Date
This column will display the value date for the position.

F. CCY1 Amount
This column will display the amount of the first currency that a position has.

G. Rate
This column will display the rate for the position. If the position is closed, the rate will be zero.

H. CCY2 Amount
This column will display the amount of the second currency that a position has.

I. Enable/Disable Floating Window

Left clicking here will cause the ‘FX Positions Blotter’ window to float out of the Workspace. It
can then be positioned anywhere on your screen. Clicking here while the window is floating will
dock it to your active Workspace.
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J. Maximize/Restore
Left clicking this button will cause the window to be maximized or restored to its previous size, if
floating.

K. Close ‘Trade Blotter’ Window
Left clicking here will close the ‘FX Positions Blotter’ window.

L. Expand Position

Clicking here will toggle a dropdown for the position, which displays the trades that have
contributed to that position. Clicking while the trades are expanded will hide the trades,
showing just the position data.

M. Order ID
This column will display the Order ID for each trade.

N. TradelD
This column will display the unique Trade ID for each trade.

0. Side
This column will display which side the trade was on, buy or sell.

P. Pair
This column will display the currency pair that the order is for.

Q. Type
This column will display what type of order initiated the trade; a Limit, TWAP, or VWAP. More
information on order types can be found in items 1 — 3.

R. CCY1 Amount
This column will display the amount of the first currency that was traded.

S. Rate
This column will display the rate the trade was done at.

T. CCY2 Amount
This column will display the amount of the second currency that an order has.

U. Trade Date
This column will display the date on which the trade was done.

V. Last Update
This column will display the date and time of the last update to the trade.
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16. Status Blotter

Clicking this button will open the ‘Status Blotter’ window. This window can be used to track and
manage the status of your orders. This window is also where Service Notices will be displayed,
alerting you to service events such as value date rolls. Clicking any of the orders in this window will
open the ‘FX Order’ window for that order, where you can modify the order if it is still working.
Below is a dissection of the ‘Status Blotter’ window.

F G H oI
‘itatus Blotter
[¥] Follow Latest
Status | Type Date / Time
USDCAD FX Order In Progress E ol
Order 130305001000000037 3/6/2013
SELL USD (LIMIT) 1.03407 04:10:19
Dof1M

USDCAD FX Order Filled
Order 130305001000000036 3@20_1
SELL USD (LIMIT) 1.03157 04:10:0
L L A R L L LN NN RI-ALY

E = SDCAD FX Order Filled
OCrder 130305001000000035 31"520_13
BUY USD (LIMIT) 1.03173 04:09:43
P00 OW OO OO O 2N
Alert
3pm market day roll. 3I§F2q13
Current Trading Date: 3/7/2013 03:00:04
Alert

D rder 5 rejected: Credit check failed. e
AUDJPY FX Order Filled

¢ ==srder 130305001000000031 3@20_13
BUY AUD (LIMIT) 95.910 12:01:53
L L A R L L LN NN RI-AEY
AUDJPY FX Order Filled
Crder 130305001000000030 3/6/2013

B =Y AUD (LIMIT) 96.132 11:43.07
LA L R R NN NN REERT
AUDJPY FX Order Filled
Order 130305001000000029 3/6/2013
BUY AUD (LIMIT) 96.135 11:42:48

e A X R R N RN B N RIS

A. Execution Status

The bubbles below an order ticket will display the percentage of an order that has successfully
executed. A green bubble means that tenth of the order has executed, a red bubble means that
tenth of the order was cancelled, and a clear bubble means that the execution for that tenth has
not been completed.

B. Order Description
This line describes the action your order is taking, at what rate it was set, and the type of order
itis.

Copyright © 2013 Ciirex Innovations LLC. All rights reserved.
The contents of this document are confidential and subject to the terms of the confidentiality agreement.

25



C. OrderID
This line lists the Order ID for the order being displayed.

D. Service Alert
This entry is a service alert detailing an order that was rejected due to credit. The one above is
an alert for a day roll.

E. Order Status

This line lists the status of the order. Statuses are: Filled — Order was fully executed, Cancelled —
User cancelled the order before it was fully completed, In Progress — Order is waiting for
conditions to complete execution.

F. Follow Latest
Checking this box will cause the status blotter to keep the most recently updated orders at the
top of the window, to easily track working orders.

G. Enable/Disable Floating Window

Left clicking here will cause the ‘Status Blotter’ window to float out of the Workspace. It can
then be positioned anywhere on your screen. Clicking here while the window is floating will
dock it to your active Workspace.

H. Maximize/Restore
Left clicking this button will cause the window to be maximized or restored to its previous size, if
floating.

I. Close ‘Trade Blotter’ Window
Left clicking here will close the ‘Status Blotter’ window.

J. Cancel Order
Clicking this button will allow you to cancel the order, if it has a status of ‘Working’.

K. Order Time
This field will display the date and time when the order was placed.
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C=1rof X

Hide Toolbar & @ Connected as test_userd
Available Credit Cancel All

Credit Limit: $100.00M Available: $97.76M
02/04/2014 Utilized: $2.24M filized %: 2.20 % FX Orders

17. Workspace

Clicking this button will open a new ‘Workspace’. “Workspaces’ are container windows that allow
you to add multiple spaces of customized information. A ‘Workspace’ can display all of the blotters
and ‘Currency Pair’ windows that you choose. ‘Workspaces’ can be manipulated like all other
windows; using the arrow button to make them float and the circled X to close the “Workspace’.

18. Credit
The credit display allows you to view your credit utilization. Below is a dissection of the credit
display.

A B C D E F

Available Credit

Credit Limit: $/00.)0M Available: $.7.76M
Lrexies Utilized: $2.24M  Utilized %: 2.20 %

A. Value Date
This dropdown allows you to select the value date you would like to display credit information
for.

B. Account

This dropdown allows you to select which account you would like to view credit information for.
The account selected in this dropdown will be the default account displayed in the ‘New Order’
window.

C. Credit Limit
This number displays your credit limit for the selected Value Date and Credit Line.

D. Utilized Credit
This number displays how much credit is utilized by the selected Credit Line for the selected
Value Date.

E. Available Credit
This number displays the amount of credit that is available to be used by the selected Account
for the selected Value Date.
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F. Percentage of Credit Utilized
This number displays the percentage of credit that is utilized by the selected Account for the

selected Value Date.

19. Cancel All FX Orders

Pressing this button starts the process to cancel all of your working FX orders. Once clicked, a pop up
will be displayed asking you to confirm your decision to cancel all FX orders. If you click ‘Yes’, all of
your working FX orders will be cancelled.

20. Pause
Clicking this button will pause all open ‘Currency Pair’ windows, freezing the prices within. Clicking it
again will resume pricing.

21. Lock
Clicking this button will disable order entry. If you click it again, you will be able to enter orders

normally.

Version History

Version 1 3/19/13 First Draft

Version 2 1/31/14 Updated the Layout, FX Positions Blotter and Credit windows.
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